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GETTING STARTED 
WINDOWS SCREEN TERMINOLOGY  
Terms the user should know before using DonorPlus: 
 
Check Box: A check box field offers two choices: on (checked) or off (unchecked). Clicking the unchecked 
box will put a checkmark in the field. Clicking a checked box will take the mark away from the field. A check 
in the box indicates the item is accepted (from here on termed “selected”). When check boxes occur in a list 
of several choices, you can select one or more at the same time. 
 
Radio Button: Radio Buttons are small circle-shaped fields, which are together to offer a multiple choice of 
items from which to select. You may select only one radio button In the List. To select, Click on the radio 
button next to the desired selection. After Clicking, a small-darkened dot will display in the radio button field. 
 
Spin-Box:  A spin box is a quick way to change a date or other numerical value. It is recommended that date 
fields be entered using the keyboard initially, then the up or down arrows be used for adjustments. Clicking 
on the up arrow will increase the number numerically. Clicking on the down arrow will decrease the number. 
(Holding down an arrow will scroll quickly up or down.) 
 
Drop-Down List: A drop-down list is a data entry field that has a down arrow on the right hand side of the 
field. Click the mouse on this arrow and a list of items to choose from will display. Click on the desired item it 
will appear in the data entry field. 
 
Elevator / Scroll bars: A window with an elevator / scroll bar will have an up arrow, down arrow and a scroll 
bar on the right side of the window. To scroll through the data in the window, left mouse Click on the scroll 
bar and slide it up or down. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CHAPTER 1: Installing DonorPlus 

 Installing on an individual workstaiton  

Close ALL programs before the install.  Verify that you have closed virus and crash protection programs. 
(These programs may interfere with the install program.) 
 
1.Put CD into CD drive it will automatically start. It may take a minute. Please be patient. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on “DonorPlus Version 3.0” to install the program 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A Program Installation screen will appear 

 Click “Yes”   
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The set up wizard will appear 

 Click “Next” 
 
 
 
 
 
 
 
 
 
 

2.The license agreement will display 

 Click “Yes” if you agree and want to 
continue with the installation. 

If you Click “No” the installation will end. 
 
 
 
 
 
 
 
 

3.Select where the program should install. 
 We recommend: C:\Dplus 

 Click “Next” 
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4.Select the additional tasks you want preformed. We recommend, “Create a desktop icon” 

  Click “Next”  
 A Setup screen will appear 
 
 
 

 Click “Install” 
A screen will show progress of the installation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Check the “Launch DonorPlus” box if you want DonorPlus to start. 

 Click Finish  
Remove the CD and Return it to your notebook and 
begin enjoying the DonorPlus 3.0.  

The next screen will ask if you want to use Actual 
Data or Sample Data.  This screen will only appear 
one time. 

 Choose “Actual Data” if you are ready to 
begin entering your own data. 
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The Welcome to DonorPlus screen will appear.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To begin setting up the program the first user name will be DonorPlus and the password is: fundraiser. 
After you set up your Program Options, each user will have his or her own, user name and password and 
DonorPlus will become the default user name. Be sure and set up the staff list immediately. This will 
ensure that if there is a problem and you lock yourself out of the program we will be able to get you back in. 
DO NOT use the default user name to sign on after the initial start up.  

  DO NOT delete this user name If you are locked out of, the program this is the only way support       
will be able to help you. 

IMPORTANT: In the case of a system failure, Do Not reinstall the DonorPlus program if you have already 
put in Data, without first calling the Help line:  1-877-285-5433. Reinstalling the program could overwrite 
donor records.  

  Choose: “Free Evaluation” if you want to evaluate the software. 
              OR 

 Choose: ”Order” if you have already made payment, or would like to do so now with a credit card.  
Make sure you have Technical support on the phone before you Click “Order DonorPlus”. 

 
 If you chose Order, the access key screen will appear titled “Access Key. Serial Number XXXXX”. During 
standard business hours, 8-5 M-F Pacific Time, contact the software provider at 877-285-5433 toll free. The 
customer service representative will ask you to read the Install ID, Please read military style, like A is alpha, 
B is bravo etc. including the dashes. (If you have not already purchased the program, we can arrange 
payment method at this time.) We will then provide the access key 

 Click “OK” 

A security feature will come up the very first time DonorPlus is started this feature will take you through 
the steps to input a key code to unlock the software if you have already made payment or choose the 
evaluation mode option. The key code may be obtained by calling the technical support number during 
normal business hours 8:00-5:00 PS/DT. In the evaluation mode, the software will allow you to enter 100 
entries. Once you have entered 100 entries, you must obtain the key code in order to enter more donor 
records. Data entered in the evaluation mode will continue to be available for review, editing, and statistical 
reporting.   

The installation is now complete. The following Chapters will explain: 
 
How to start a session in the DonorPlus program 
The basics of the DonorPlus program initial screen 
How to end a session in the DonorPlus program 
Go to Chapter 4 to set up the Program Options and Chapter 5 to set up your Lists. for your non-profit 
organization. 
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 Installing on a Network 

To install the DonorPlus program in a network 
environment, and run as a stand-alone program. 
The following conditions must be present in the 
network. 
 
1.Workstation is MS windows 95B, 98 or NT4.0 SP3 
or above 
 
2. SERVER. 
    A.    Ensure the server is stable. 
 
    B.    Install SP4 for NT 4.0 or the current Netware 
           patches for Netware 3.12 and above. 
 
3 The following network setup should be present in 
the windows workstations. 
 
  PROCEDURE 
 
A. Server: 
    A.1   Ensure the servers date and time & all 
workstations (which will have the software installed) 
date and time are current. They do not need to be 
synchronized but should be within a few minutes of 
each other. This is keeping the data integrity and the 
reports correct. 
 
    A.2  Install the "Program" on all workstations on drive C. The Data folder goes on the server. Then change 
the dplus.ini on each workstation to: Datafiles=F:\data (or whatever your network drive is) 
 
    A.3 Continue with B below for the workstations.  
 
B. Workstation: 
 Map a drive to the root of the shared partition on the server (NTFS on NT or SYS volume on Netware. 
Typically, this has already been done and the drive letter is F: Use NetWare mapping or on windows peer to 
peer or client to NT server use the "NET USE" command as a login script. The syntax should be: net use f: 
\\server_ network_name\f /yes this will map a local drive F: from the server name drive f. In this case, the 
server name is server_ network_name and the drive where cisdata folder will be is shared as f. 
 You should put this in a batch file and then put a shortcut in the startup folder or put in the registry in the run 
once key. 
 
    B.1   The shared partition on the server must be available to all users of the program. 
 
    B.2   Contact your network administrator to accomplish this task.   
 
    B.3   The current version is not fully shareable. An message will occur if more than one computer tries to 
access the data at a time. This message will let the new user know that the program is already running on 
another computer or their own computer. 
 
    B.4   The CISWIN program install at this time allows one user to access the data at a time.  
 
    B.5   However, many computers in one center may have the program installed at one time. 
 
    B.6   Install the software on all computers in the center on the same day. Call at one time to get a key for   
            each workstation. 
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CHAPTER 2: Basics about the DonorPlus program 

Opening a session in the DonorPlus program 
Using the Windows Start Button 

 Click “Start”  
The Start Menu will display  

 Scroll with the mouse to: Programs. A menu will display to the right of the start menu. A small menu 
will display to the right of the Programs menu 

 Click ”DonorPlus”. 

Using the Desk Top Icon 
If a shortcut icon was placed on the desktop at installation of the DonorPlus program, 

 Click the “DonorPlus” icon 

 After Clicking on the “DonorPlus” icon either from the START menu or on the desktop, the title screen will 
display followed by a pop up window with the default user name (DonorPlus), and will ask for the 
password, the default password is: fundraiser. 
 

If this is your first launch of the Program sign on as “Single user” (If you are using Multi-User Version) This 
will allow you to set up the master lists, Staff List, and Program Options.  
 
 Be sure and set up the staff list immediately. This will ensure that if there is a problem and you lock yourself 
out of the program we will be able to get you back in. DO NOT use the default user name to sign on after the 
initial start up.  

 Click “OK”.  

To make this program work for you as designed, we strongly suggest that you do the following in this order: 
1. Read this manual, and keep it in front of you as you go to install and set up the program.   
2. Install the DonorPlus program 
3. Set up your “Program Options” under the “Edit” Menu first. This is a very important step as it makes the 
difference on what is displayed in donor records This area your Organization Information, default fields for 
exporting to mail merge, City, State options and record numbers.  See Chapter 4. 

4. Go to “Lists” on the Menu bar and set up the staff list, GL Accounts, Appeals and Master lists.  
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DonorPlus is not an accounting program; it is a Donor tracking program designed to interface with 
your accounting program. If you are not comfortable with accounting, have your accountant set up the 
General ledger accounts. They must be typed character for character (upper case, lower case, spaces 
etc.) in your DonorPlus program to export properly to your accounting program.  
 

EXAMPLE: 
  
        GL ACCOUNT                    APPEAL        EVENT 

   
 General Funds                      3001                   New Roof 

 
Walk for Roof 
Garage Sale 

Building & Maintenance        3002 General Funds 
 

 Bake Sale 
Spring Carnival 

 Monthly Bills Winter Banquet 1999 
Banquet Income                    3003 

 
Client Services                       3004 

Banquet 1999 Summer Banquet 1999 
Spring Banquet    1999 

 Banquet 2000 
 

Spring Banquet 2000 

 Client Supplies 
 

Fall Banquet 2000 

  Summer Banquet 2000 
   Street Dance 

 
A GL Account is a General Ledger Account. 
This tells you and the accounting people which account the donation was put in this must match your 
accounts in QuickBooks if you are panning to export to that program.  
 

Appeal Name. This is the issue list. It is the reason you are having the event. 
 

 Example: funds for a new roof, office equipment, etc.  
 

1. You are now ready to set up the Master data lists, Staff list, and Program options. It is 
very important to do this. If you think it will take too much time and you will come back 
to it later, you will find it very difficult to fill in the donor information etc. So, save some 
frustration and do it now. See Chapter 5.    

2. The next step is to enter in your events, if you have any coming up or if you are 
entering information from previous months or years, do this as your next step.  

It is important to choose your Event name and Appeal carefully. This way later you can see that your 
Concert for life raised X amount of money for the new roof, and it will go into the correct accounting field 
in your accounting program. 

3. Enter all of your donors. Put in all the information you can, it should be easy now that 
you filled in the entire master lists. Make sure you give your donors identifiers. (Walker, 
host, volunteer, etc.) When you go to do reports or mailings you will be able pull 
donors by the identifiers. 

Now start entering the donations (or gifts, as it is called in the program.) A Gift is any amount of money given 
by a donor. A Pledge is an amount they say they will give for a certain appeal or event later   DO NOT put 
this into gifts. It is not a gift until you receive it. See Chapter 9.Configuring the Software 
 
Configuring the software means tailoring the database and Program Options to meet the informational needs 
of your non-profit organization. This software allows reporting based on configurable items such as the 
areas, contact activities etc. 
 
There are two sets of configurable data, which will need to be set up initially, BEFORE you begin to enter 
donor data. The first, “Program Options”, is included in the Edit menu. The second set includes several 
Master Lists in the List menu 
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CHAPTER 3: “File” Menu Options 

File Menu 
This menu item includes files and system level tasks.  

 Click “File”  
A drop down list will appear with the following options 

New: 

Opens a new screen which to enter data to create a new Donor record. 

Open:  

Opens the record that you highlighted on the work center. 

Print Gift Receipts:  
From the “File” Menu item  

 Choose “Print Gift Receipts” 

Print Pledge Statements:  
From the “File” Menu item  

 Choose “Print Pledge Statements” 

Print Giving Statements  
Printing your “End of the Year” “Giving Statements” 
 
From the “File” Menu item  

 Choose “Print Giving Statements” 

Export Gifts to Accounting:  
This will export your info into your QuickBooks accounting system. 
You must set up your export file name in the Program Options 
under the Edit menu before this option will work.   

 Click “Export to Accounting” from the File Menu 
 A screen will appear that is building your export table, once 
complete the following screen will appear.  
Select the gifts that you want exported. 
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 Click “OK” 
The next screen will tell you the export is complete, tell you the Export file name and Amount Transferred. 

 

een will close. The report will appear on the screen, at this time, you can choose 
 send it to the

 

(I  ust be in single user mode.)  

 already signed in. A supervisor will have to sign in and Click 
on c  the user can get back in.  

cords 
ill 

a he event of a power loss, or each time you close or reopen the program  

R  indexes with new indexes.  

This is one way to exit the program.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click “OK” 
You will be asked if you want to print the gift posting report. If you choose “Yes”, your Gift Posting report will 
ppear. If you Choose “No” the scra

to  printer or close it. 
 
 
 
 
 
 
 
 

 Utilities:  
n order to run these you m

 Clear Record Locks:  

If the program locks up on a user or not shut down properly, 
 when that user goes to sign on, it could say they are

lear record locks so

 Rebuild Index Files: 

 Index files keep the records in the database sorted properly.  The index files are automatically updated as re
are added or changed we suggest, however, that you run this routine about once a week.  The program w
utomatically run this routine in t

 Verify Data Integrity: 

eplaces

Exit:  
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CHAPTER 4:  “Edit” Menu Options 

Setting up the “Program Options” 
Edit Menu 
This menu item is to set up your “Program Options” and “Receipt/Statement Preferences” 

Configuring the Software   
Configuring the software means tailoring the database and Program Options to meet the informational needs of 
your non-profit organization. This software allows reporting based on configurable items such as the areas, contact 
activities etc. 
 

There are two sets of configurable data, which will need to be set up initially, BEFORE you begin to enter donor 
data. The first, “Program Options”, is included in the Edit menu. The second set includes several Master Lists 
  Click ”Edit” on the Menu Bar, “ 

The “Edit” menu will drop down 

 Click ”Program Options” 
The “Program Options” Window will display. This is basic information about 
your non-profit organization. There are four sections of information stored here: 
Organization Information, Preferences, Accounting, and Custom Fields.  
 
 
 
 
 
 
 The following are instructions 
for setting up and making 
changes to the “Program 
Options”: 

 Organization Tab 

Serial # 

The serial number is set by the 
software provider and cannot be 
changed 

Non-profit organization Name: 

The software provider sets the 
non-profit organization name at 
the time the customer places 
the order. To change the name of your non-profit organization change, contact the software provider. 

Address, City, State, Zip (code), Phone, Fax, and e-mail (address): 

Enter data into fields. The zip code field will accept either the 9-digit USA code or the alphanumeric  
Canadian code. Leave fields for which there is no data blank. 

Federal Tax ID 

This is your non-profit organization Federal Tax ID number for your donors tax purposes. 

State Tax ID 

 This is your non-profit organization State Tax ID number (if applicable) for your donors tax purposes. 
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Preferences Tab 

 Multi–User Options 

This area enabled by support. 

 Country Options 

“Include Country in local 
mailing” Check this only if 
you want the country printed 
on mail to the same country 
as your organization resides  

ry, 

 

ry. 

 
For example if your 
organization is in the USA 
and you want all mail within 
the USA to print the count
check this box.  
If you do not want USA to 
print on all local mail within
the USA, uncheck the box 
and only mail going outside of 
the USA will print the count
 It is important that the organization country be filled in under the Organization tab of the program options for this 
setting to work properly. 

 Country Options 

“Include Country in Local Mailing” 
Check this if you want the Country, (example USA) included on the mailing lists, envelopes etc. 

"Enable default country field" 
Check this if you want all new donors to automatically fill in with the “Country”  

 Default Fields 

“Enable Default City” 
Check this if you want all new donors to automatically fill in with the “City”  

“Enable Default State” 
Check this if you want all new donors to automatically be filled in with the “State” you choose from the drop down 
menu. 

 Record Numbers 

The Record Number field is where you put in the beginning numbers you want your non-profit organization to start 
with. After this first entry, it will automatically number each Event, Donor, and Gift record. Once this is set, you 
cannot change it. 

 Data Preference 

Use Sample Data. This is for evaluation purposes. Uncheck this box when you are ready to begin entering your 
organization data. Default Export File Name. 
This is for your mail merge option. Go ahead and leave it as Export. 

 Export File Directory 

This will be the file that you export to mail merge.  
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 Accounting Tab 

If you are using QuickBooks: 

 Click “Enable Accounting 
Interface”  

 Choose an Export 
Path for your export 
accounting file. 

 Example: C:\dplus23\expacct 
Name your Debit Account. 
This must be the same as in 
your QuickBooks program. 

 Custom Fields Tab 

This screen allows your non-
profit organization to 
customize your Donor Profile 
even more. In each of the 
custom fields, you can type in 
the information that your non-
profit organization wants to 
know about its donors. The 
first three fields are for specific categories the second four are for dates. These fields will show up in the areas of 
the DonorPlus program.  
 
Example: Custom 1,2,3 could be for 
Number of Children, Children's 
names, Hobbies, etc. For dates: 
Spouses birthday, anniversary, first 
became a donor, etc. Fill in The 
custom filed name for the event If 
you check the Enable Default 
Country box, the country you 
choose will automatically fill in, 
(example, if the majority of your 
donors are in the USA make that 
your default country) This will save 
you time when filling out your 
records.  
 
 
 
 
To restore to the default fields 

 Click “Restore Default” 
The Custom Field “Event Record” is where you can customize a field in the Participant information screen in the 
event records. Instead of reading Custom Field, it will read what you have chosen in the Program Options. 
To restore to the default fields 

 Click “Restore Default 
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Setting up “Receipt /Statement Preferences “ 
 Choose “Edit” From the Menu bar  

A drop down list will appear  

 Click “Receipt/ Statement Preferences” 
You have five tabs for setting up your letters. Each letter is set up the same so 
we will only show Regular Gift receipts in this manual. Follow these steps for 
each of the letters or statements. 
 
Once you have the receipt or statement screen open, you can choose your font, Letterhead, and Top margin. (All 
receipts under each tab will 
need to be in the same font, so 
when you go to print all gift 
receipts your printer can handle 
it. If you want a particular 

 
a
r

 “Edit” to change a 

ipt 
ist or  

ck “OK” to leave this 
scr

onors etc.) Therefore, you can identify the correct letter later when 
ou choose to print receipts or statements. This name will NOT appear on your receipts or statements. 

he Title WILL appear on your receipt or Statement  (See example) 

 

receipt to print with a different 
font, you will have to print all of 
those separate. 
Go through the following steps 
nd after clicking “Back” you will 
eturn to this screen  

 Click “New” for new 
receipt,
previous receipt, or ”delete” if 
you no longer want that rece
in your l

 Cli
een 

If you  
 Choose “New”  

Name your letter  
(Banquet Letters, General Donations, Major D
y
 
Title 
T
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Type the body of your letter;  

 Insert your Closing  
 Choose name of Signer from drop down list. (The names from the Signer drop down list come from your 

Staff List.) 
 Check the Include “Person Sponsored”, “Federal Tax ID #” and/or “State Tax ID #” if you want this to print 

on your letters.   See sample on where these appear on your letters or statements. 

 Click “Back” 

 Click “OK” 
Now go on to the next letter, 

  Choose another receipt, statement or close. 
Once these are set up, you will be able to choose the letter to print for each event as you set up new events. 
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CHAPTER 5: “Lists” Menu Options 

Various lists that are included in the DonorPlus Record Screen can be configured (customized) for the database 
used by your non-profit organization. Setting up the master lists is an important aspect of maintaining meaningful 
and accurate statistics.  These lists greatly enhance the speed and consistency of data entry. The lists should be 
set up once upon initial install then modified only when transitioning to a new calendar/statistical year. You must be 
signed in with Administrator rights and in single user mode to access these lists. 
We do not recommend deleting entries from the Master lists once they have been used in your Donor Records.  
The procedure for configuring each list is the same (with the exception of the Staff List, which has a more 
extensive data entry screen) therefore, the steps are shown only once for configuring the Donor Type 
Master Lists. Refer to the instructions as needed while configuring other lists. It is not necessary to 
configure in a specific order.  
 
Example: After the last donor record for 2004 has been entered, before entering any donor records for 2005 would 
be appropriate time to make changes to the configuration. 
 If you choose to make configuration changes more frequently, data integrity on donor records are at risk. 
Configuration changes will cause the year-to-date and year-end statistical reports to have lapses for months in 
which the new configured items were not included. For consistent statistical reporting keeping, the same 
configuration for the reporting year is essential. 

  Click “Lists” on the Menu Bar  
The List menu will drop down 

 Click list titles in turn to configure each list.  

Setting up the Master Lists 
In the List menu  
 Click ”DONOR TYPE”  

(We have chosen this one for sample purposes all of your Master Lists  
will follow these instructions) A pop up window will display entitled “Donor Type List”. 

 To Add a new Donor Type  

 Click “New”  
A pop up will display on top of the master list Window 
Enter the Donor Type in the field  

 Click “OK”  
The pop up will close the new Donor Type will appear In the List  
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 To Edit a Donor Type  

Highlight the Donor Type to edit 

 Click “Edit”  
A pop up will display on top of the Master list window  
Make desired changes. 

 Click “OK”  
The pop up will close the changed Donor Type will appear In the List  

 To Delete a Donor Type (not recommended)  

Highlight the prefix 

 Click “Delete” 
A pop up will display on top of the Master list window verifying that the Donor Type to delete (if this is a system 
record you will not be able to delete it). 

 Click “Yes” to delete the 
Donor Type 
 
 
 

The pop up will close.  
The list will display with the Donor Type deleted. When all entries are made correctly,  

 Click the” X” in the upper right hand corner of the window to close. 
The other nine Master lists are set up in the same way. 

Setting up the GL Account List 
You must set this up exactly as your accounts are set up in QuickBooks if 
you are using QuickBooks, for the export to work 
. In addition, we want to make you aware that if you choose to make a GL 
Account called Other Income it will go into an account type in QuickBooks 
called other income as opposed to an account type income. This is a 
QuickBooks restriction and we cannot change it. However, you can call it 
other1 income. Then it will go into an income type of account. 
In the List menu  
 Click “GL Accounts” 

 A pop up screen will appear 

 Click ”New”A pop up screen will appear  
Type in a GL Account Number in the blank field 

 Tab  
Now fill in a description in the blank field Click the radio button if this is 
tax-deductible account 

 To Edit a GL Account  

Highlight the Account 

 Click “Open”  
 A pop up will display on top of the master list window, make desired 
changes 

 Click “OK” 
The pop up will close. The changed Account will appear In the List (in alphabetical order). If you change the tax 
deduction you will need to go into the appeals list, highlight the deduction you changed in the GL Account Record. 
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  Click “Edit”, “OK” and it will make your changes. 

 To delete an Account  (not Recommended)  

Highlight the Account 

 Click “Delete” 
A pop up will display at the top of the Master list verifying the 
Account to delete   

 Click “Yes” to delete the Account  
The pop up will close. The list will display with the Account deleted.  

 Click “OK” 
Follow the directions above until you have entered all of your different accounts. 

Setting up the Appeals List  
In the List menu 

 Click “Appeals”  
A pop up window will display entitled 
“Appeal List” This screen will be blank. 
We have filled it in for example purposes. 

 Click “New”   
A pop up screen will appear Type in the 
Appeal Name in the blank field 

 Tab 
Now you are on the GL Account field  

 Click the ”arrow” to the right 
A drop down menu will appear 

 Choose the “GL Account” for this 
Appeal 

 Tab 
Type in the Date Begin for the Appeal (required)  

 Tab 
Type in the End date for the Appeal (required) 

 Tab down to “Support Type” 

  Click in the appropriate box for Direct Support or Indirect 
Support. 

Direct Support  
Example: You offer to pay this months rent for your favorite 
charity. It would be tax deductible and indirect if you paid it 
directly to the property owner. 

Indirect Support 
Example: You offer to pay this months rent for your favorite charity. It would be tax deductible and direct if you 
gave your charity the money and they wrote a check to the property owner. 
Go back to new if you have more entries to make and follow the previous directions. 

Setting up the Staff List  
In the List menu,  

 Click “Staff”  
 A screen will display entitled, “Staff List”. The administrator should set this up. 
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When it displays the first time it will be blank, after you have added the staff names, they will list in alphabetical 
order by last name. It is important to fill in your Staff List. Not only can you assign a user name and password to 
staff that will be using the DonorPlus program, but also as shown below, you will have a record of phone, 
address, e-mail, birthday, Social Security number etc. in a report that you can print out 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 To create a new staff record  

 Click “New”  
A screen entitled, “Staff Information” will display Enter appropriate data in fields. Assign each staff member that 
will be using the program a user name and password.  The password will be masked (no matter what you type in, 
when you hit the tab key, the whole line will fill in.)  

 User Rights 

 This will allow the access to only certain records depending on the level checked. (Be sure at least one person has 
Administrator rights)When all entries are made  

 Click “OK”  
The Staff List screen will replace the Staff information screen. To create another new staff record  
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 Click “New”  
Repeat the steps and add all staff members  

 To edit an existing Staff Record 

In the Staff List screen,  
  NOTE: If a staff member changes their name, DO NOT edit the record. Create a NEW staff record with the 
changed name. The former name must remain the same because it is a key data element on Donor records. 
Highlight the staff member listing that needs to be changed 

 Click “Edit” 
OR  

  Click the Highlighted name. 
The selected staff record will display. Make appropriate changes. 

 Click “OK” 
To abandon all changes made to the current staff record 

 Click “Cancel”. 
The Staff Record screen will close and the Staff List Screen will display. 

 To delete staff records (not recommended) 

When a staff member becomes inactive, DO NOT delete the name from the Staff List. The name must remain on 
the list because it is a data entry element on Donor records and is for statistical and reporting purposes.  Deleting 
any Staff record will be at the request of the Non-profit organization Director only. 
 
Now you are ready to begin entering Donors, Events, Gifts, etc. 
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CHAPTER 6: Entering Donors 

 Donor Record Screen  
 Click the “Donor” button on the Work Center The main Donor Record screen will display  

  Click “New” at the bottom of the screen.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following screen will display, begin filling in the information 

 Main Profile Tab 

Donor record 
number: 

This field is automatic 
and cannot be changed 

Date created   
This field is automatically 
filled in with date on 
which data entry is 
made; however, it is 
important that the date is 
changed to the date on 
which the initial donor 
record was filled out. If 
you need to change the 
date, highlight and over 
type with correct date. 
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Donor Type 
 Click the radio button to the appropriate donor type, Individual or  organization. The screen will be different for 

the type of donor you select. 
 Click the arrow to the right of the field 

A drop down menu of data entry option will display (This is the list created in the master List) 
Scroll down the list with the mouse until you highlight the appropriate source. (It is important to fill this in correctly 
as this will be the prefix that shows up on all your letters, mailing etc.) 
 
NOTE: If the list is too long to fit the drop-down menu window – use the mouse to scroll with the elevator/scroll bar 
through the list. (If you need help, see getting started in Chapter 1.) 
Release the mouse and verify that the correct entry is in the field. 
 Click “Enter” 
        OR 

Enter the first letter of the source entry you wish to make. (This box will only show when the radio button is selected 
for individual) 

Source  
 Click the arrow to the right of the field,  

 A drop down menu of data entry options will display. Scroll down the list with the mouse and highlight the 
appropriate source. 
 
NOTE: If the list is too long to fit the drop-down menu window – use the mouse to scroll with the elevator/scroll bar 
through the list. (If you need help, see getting started in Chapter 1.) 
Release the mouse and verify that the correct entry is in the field. 
 Click “Enter” 

OR 
Enter the first letter of the source entry you wish to make. 

Example: If the source is “Walk-a-thon” you would hit “W” on the keyboard.  

Prefix 
 Choose the prefix for this donor from the drop down list.  (You created this list from the Lists menu. 

You can always add to this if necessary).  
 Tab 

Type in First name  
 Tab 

You will see that the informal and formal fields automatically fill in. Continue filling in the middle initial if any and last 
name. 

 Tab 
Now the informal and formal fields filled. This is what the letters and receipts will pull from when you chose “Formal” 
or “Informal”. If you want it to read different, highlight the field and retype. 

Preferences 
In this field, you can click to include this donor in mailings, reports, and send statements. 
If buttons are NOT checked, this Donor or Non-profit organization will not be included in mailings or reports 

Best Contact 
Information on when the best time and day is to contact your donor 

Primary address, e-mail, phone 
This field is for the primary address of the non-profit organization; address line one and lines two are for the primary 
address. Use line two for apartment number, suite, etc. Fill in E-mail address you can also keep track of the county, 
area, and country for doing specific reports. There is space for evening phone, day phone, cell, fax, pager, and 
other. Just use the arrows on your keyboard to scroll through the list. 
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Alternate Address 
The top of the record will stay the same; the bottom will give a new form so you can enter an alternate address for 
the donor. This alternate address screen will allow you to put in dates that this alternate address is current. For 
example, if your donor goes to Florida for the winter put the effective dates 10/01 to 03/30. Then when you go to 
send out letters or receipts the program will automatically pull this alternate address during these dates. 

Attributes Tab 
In this screen you fill in the features of the Donor the custom areas will have the titles that you set up in the 
Program Options in Data master list. Such as: Number of children, Children’s names etc. The User Def area will 
have the titles of the dates that 
you set up. Such as: Spouses 
birthday, Anniversary etc. 

Contact Activity Tab 
Keep track of the contact you 
make with your Donor. The date 
will automatically fill in with 
today’s date 
Recording a new contact 
activity 

 Click the arrow to the right 
of the User Name   

A drop down list will appear  

 Click the name of the 
person making the contact.  

 (These names are from the 
staff list database) 

 Click the “Activity” 
arrow  

A drop down list will 
appear 

 Click the activity 
 (These activities were set 
up in master list) 
Go the Comments field 
type in your comment 
Go to the bottom of the 
screen and select the 
Follow up radio button 
and fill in date if there is to 
be follow up on an activity 

 Click in the “Date” 
field and put the date for 
the follow up 

 Click the arrow in the 
“Next Activity” field, use 
the arrow to select the 
next activity for the follow up 

 Click “New Activity” the new activity will show up in the top box 
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 Identifiers Tab 

Set up identifiers for each donor such as golfer, skier, etc. It is important to set this up Then when you do a 
mailing, or want to pull names for a particular mailing you can use these identifiers to select groups of donors Your 
list comes from where you set up the master list and this is where you will go to add or change an identifier. You 
can give as many identifiers as you want for each donor 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To select identifiers for a donor 
Highlight the identifier on the left-hand side  

 Click “Select” 
The identifiers will display on the right hand side 

  Choose as 
many identifiers 
as fit for this 
donor.  Later 
when you want 
to run a report 
of say all 
volunteers. You 
will be able to 
pull the 
volunteers from 
the identifier 
you gave them. 

To remove an 
identifier (not 
recommended) 

Highlight the identifier 
on the right hand side   

 Click “Remove” 

 Gift History Tab 

This screen shows the gifts the donor has made, date, amount, event etc. you cannot enter information here this 
will fill automatically as you enter gifts in the main Gift screen. The Donor Record is now complete Go back to main 
profile. 
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 Accessing  a specific donor record 

 Click one of the fields from across the top of the screen 
  If you have chosen Last name for example you can begin typing in the Last name in the “Find Donor” area at the 
bottom of the screen, the Donor with that last name will come up highlighted  

 Click “Open” 
Highlight the contact to edit 

 Sorting the Donor List 

The Donor list screen 

 Clicking one of the buttons across the top will sort records by that category 

 Clicking the same button a second time will sort the list category in reverse order. 
 (It is useful to sort by this method using the category which will help you access a donor most easily) 

You can also search by using specific data for each of the categories listed. 

 Click the “Open” button – the donor screen will display  
Make changes or additions 

 Click “OK” 
Note: You cannot 
change the donor 
record number– 
This is tied to its 
respective fields in 
the Donor Record screen. 

 Deleting a donor contact record 

Highlight the contact to delete (the initial contact cannot be deleted.)  

 Click the “Delete Activity” button. 
A pop up alert will display asking, “Do you really want to delete (donor name)?” 

 Click “Yes”. 
The alert will close and the contact listing will delete from the Contact Activity section. If there is an open pledge 
balance, you will not be able to delete the record. 
The Find field in the lower right corner of the screen will match the category selected for sorting.  To quickly find a 
donor, enter the known data for the category and Press “Go”. 
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CHAPTER 7: Entering a New Event  

 Click the “Event" button  
 The main Event Record screen will display  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Click “New “ at the bottom of the screen. 
A pop up screen will appear.   

 Choose the” type” of event to create. 

 Click “OK” 
Depending on the type of Event, you choose a screen will pop up 

 Admissions 

  Click the radio button  “Admissions” 

 Click “OK” 
 The following screen will appear.  
Type in the Event Name 

 Tab over to each of the 
fields and fill in 

 Tab over to the Participant 
Information  

Fill in the Participant information to 
keep track of Costs and Goals. 
The Income, Expenses, and Net 
Income totals can be seen on the 
Accounting Tab.  

 Select 
Receipts/Reminders from 
the drop down list that you 
will use for this event. This 
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can be set up later if you prefer. 
To set up your receipts and letters go to: “Edit” on the menu bar,  

 Choose Receipt/Statement preferences. See Chapter 

 Accounting Tab 

The participant information you filled in on the previous screen will appear here As you enter Pledges and Gifts for 
this event you will be able to see how many open pledges there are, how many gifts, the goal you have set and the 
Actual amount you have received. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Participants Tab 

This area will list the participants of this event. It will show the outstanding pledges and paid Gifts. 
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New Mailing Event 
This area is for setting up lists for newsletters, announcements, mail merge, Target donor list, mailing labels. 
Anything you might need a list of donors for that does not include the entering of gifts or pledges. 
 
From the Events button 

 Click “New” 
 Choose  “Mailing” 

 Click “OK”  
Step 1 – Mailing Event Admin screen will appear 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Tab through the fields filling in Event Date, Mailing Date, Event name, coordinator, and Appeal. 
 Choose the Receipts that you set up in Receipt/Statements Preferences that will go with this Event. You 

will not need to do this if this is just going to be a mailing. 
 Choose radio button for which you want to send this mailing to “All Records” is every donor in your 

database that matches the search criteria you are going to select. Only Records checked “Include in 
Mailing” are donors who you checked in their donor record “Include in Mailings” that meet your search 
criteria. 

   Click “Next”  
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Step 2 screen will appear 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Here is where you will define your Query (Search Criteria)  (our sample was filled in as below) 

 Click “New Line” 
Go to “Modify Line 1” 

 Click the arrow next to “Rules” 
A drop down menu will appear. Choose “Of those Included”, “Include Donors” or “Exclude Donors” 

 Choose Identifier in the “Field Selection” area and in the  “Match Criteria” field 
  Choose “Golfer” from the drop down menu. 

 Click “Next” 
Step 3 screen will appear  

 Select Fields for Export File (This is for doing a mail merge)  

  Click “Finish” 
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Step 4 screen will appear 
 
You will see the results of your search criteria.   
You now have the choice to choose “Show Fields selected for Export” which will show all fields that were chosen by 
you in Step 3 that will export into mail merge or choose “Show all Available Fields” which will show all fields from 
screen 3 which also will export into mail merge. . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can now choose to “Create Merge File”, “Mailing Labels”, or “Target Donor List”  
 
Target Donor List (as shown on next page) is a list of donors from your search criteria. It will show “Donor ID#”, 
“Contact\Title”, “Name\Address”, “Day Phone”,” Last Gift Date”, “Last gift amount” it doesn’t matter what you have 
chosen in Step 3, Target Donor List is always the same. See sample next page. You can now print this report out. 
 
If you choose “Mailing Labels”, the following screen will appear.  Put your labels in the printer and print your mailing 
labels. 
 
If you choose, “Create Merge File” go to chapter 11 to see how to do a mail merge. 
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CHAPTER 8: Entering a New Pledge  

 Pledge Record Screen  

 Click the “Pledge” button  

 Click ”New” at the bottom of the screen.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

The main Pledge Record screen will display Today’s date will automatically be inserted, if date of Pledge is 
different change the date.  

 Tab to Donor  
Type in the first letter  
of the last name of  
the donor. A drop down list will 
appear with a list of your 
donors.  

 Click the name of the 
person who is making this 
pledge their name will appear 
in the Donor  field  

 Tab over to Amount 
Pledged 

Type in amount of the pledge (if 
they pledged 10.00 a month for 
a year, the pledge amount 
would be 120.00 dollars) The 
“Payment schedule” will 
automatically fill in with how 
many payments are due, the 
amount and date of each 
payment You can put in pledges for up to 10 years. Put in the total amount they pledged for how many years the 
program will automatically fill in when the first and last payments are due and how much each payment should be. 
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 Click the Event for this donation the event will show in the field, The appeal field will fill in automatically 
 Tab over to the Person Sponsored field 

Type in the name of the person this donor is sponsoring, if any 
 Tab again, which will take you to the “Payment 

Schedule”  

 Click the arrow to the right 
A drop down list will appear, 

  Choose how this donor is going to schedule their 
payments. (Lump sum, monthly, quarterly etc.) 

 Tab  
You will see that the rest of the fields have now filled in. It 
will show how many payments, amount of each payment 
and when each payment is due. 

 Tab 
You now will be on the Options Field  

 Click the “Active Pledge” box if this is a pledge that is 
being paid and kept current 

 Click the “Send Reminder” box if you want this 
persons name brought up when you go to print   
reminders. 

 Choose the collection likelihood for this pledge.  
 Choose 10 if you are sure this person will pay their 

pledge off; one if you think there is no chance.   

 Click “OK”  
You will be taken back to the “Work Center” screen where you will see the donor’s name, amount pledged, balance, 
and appeal.  
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CHAPTER 9: Entering a New Gift  

  Gift Record Screen  

 Click the “Gift” button  
The main Gift Record screen will display Today’s date and receipt number will automatically be inserted, if 
date of gift is different change the date. You cannot change the receipt number. Be sure and Click the radio 
button for the type of receipt you will later print out (none, first time giving, regular giving or Gift in Kind) To 
Click the Gift in Kind, you must make sure the you choose gift in kind in the Form of Payment box. Do not do 
anything with the Posted to Accounting box.  That automatically checks after you import your accounts to your 
accounting program. (If you are not using an accounting program that interfaces with the DonorPlus 
program, then you will have to manually check this box as you post your accounts) 

To Enter A New Gift 

 Click the “Donor” Name field 
 Type a letter  
 A drop down list will appear with a list 
of your Donors  

 Click the Donor for this record it 
will appear in the field 

 Select Payment Type 
The print Receipt field will 
automatically fill in the correct radio 
button depending if this is a first time 
gift, regular gift, so when you go to 
print receipts the program will know 
which receipt to use. You can  

 Choose “None” if you do not 
want a receipt to print out for 
this gift. 

 Click “New Line”  
The following screen will appear 

 Click the arrow to the right of the 
Event field 

 A drop down list will appear. 

 Click the Event  
 Tab   

 If there is a person Sponsored, type the 
letter of the last name 
A drop down list will appear 

 Click the person sponsored if any 
and highlight name 

 Click “OK” 
You will go back to the Gift record screen, which will show this gift in the Gift Distribution area. When you go into 
Gift History from the main Donor record screen the gifts that this donor has made will display along with the 
average gift amount, first gift latest gift, largest gift etc.  
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 Click the person sponsored if any and highlight name 

 Click “OK” 
You will go back to the Gift record screen, which will show this gift in the Gift Distribution area. When you go into 
Gift History from the main Donor record screen the gifts that this donor has made will display along with the 
average gift amount, first gift latest gift, largest gift etc.  
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CHAPTER 10: Entering a Pledge Payment 

 Entering a payement to a Pledge 

After your Donor has pledged money for an event, they will begin to make payments or pay in a lump sum. 
To post the payments: 

 Click the “Gifts” button  

 Click “New” 
The following screen will appear: 

 Click the name of the donor making this payment 
 Tab to the “Form of 

Payment” 

 Click “New Line”  The following 
screen will appear: 

Go to the bottom of the screen  

 Click “Use Pledge” button 
        NOTE: If you do not do this, 
the payment will not deduct properly 
and your accounting will be off.  
 If this is, New Gift and not a 
payment go to entering a new gift. 
 This will automatically fill in the 
Event, Appeal and payment amount 
that this donor has made a pledge 
to. This amount comes from the way 
you set up the Pledge. (Monthly 
payments, semi-monthly etc.) If the amount of this payment is different, change this amount to the amount of 
payment.  

 Click “OK”  
You will go back to the main work center screen with your donor’s payment showing.  
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CHAPTER 11: How to do a Mail Merge 

Mail merge is a program in Microsoft word that works with DonorPlus. It enables your non-profit organization to 
print letters, envelopes and labels to specific donors or all donors from your DonorPlus database with a 
customized letter. You can print thank-you letters, invitations to upcoming events, etc.  Microsoft Word Type in the 
body of your letter. Mail merge will add the names, dates, etc. and then print your envelopes or labels to 
correspond with the letters.  
Follow instructions in chapter 8 under “Mailing” When you get to Step 4 you will click on “Create Merge File” 
 
The following screen will appear. 

 Choose how you want your export sorted.  
You can also change the name of this export. Example if this  
is a June mailing, type in June in the “Enter export file name.  
 Doing this will keep each export in your Docs folder for use later.  
If you do not want to save each one, keep the name “Export”  

 Click “OK” 
The following screen Will NOT appear,. If you have chosen to change 
name.  If you keep the same name, the following screen WILL appear 

 Click “Yes”  
 
 
 
 
 
 
 
After clicking “Yes” or “OK” you will be looking at screen Step 4.  

 Click “OK” you will be taken back to the Event screen, you are now ready to merge this information with 
Microsoft word and print your letters. 

Open Microsoft Word.  
 

 On the Menu bar 

 Click “Tools”  

 Click “Mail Merge 
Mail Merge Helper screen will appear 

 Click on Create then form letters 
oose Mailing labels if you want labels for these letters. 

 

You can go back later and ch
” 
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 Click on “New Main Document” 
 A blank Word doc and Mail Merge Helper 
will appear. 

 Click on “Get Data”, “Open Data 
Source” 

Go to the export path you specified in 
setting up your “Programs Options” 
At the bottom of this screen, you will see 
“Files of Type”  

 Click the arrow to the right of this 
field  
 Choose “dbase files” 

You will now see your export file Click the 
file  

 Choose “Open” 
The following screen will appear  

 Click “Edit Main Document”  
Your blank document will appear.  
Now you can begin typing your letter and 
inserting merge fields. 

 Click on “Insert Merge Field” from the 
menu at the top of your page  

 The fields showing will be the ones you 
chose on Step 4 in the DonorPlus 
program. As you are typing, you can go to 
“Insert Merge field” from the menu bar and 
chose the item to insert. 
 Now go to the Menu bar  

 Choose “Merge” 
Your letters will fill in with the information 
you have chosen. You can now scroll 
through each one or just chose print and 
your letters will print on individual pages. 
 
To print your envelopes go through the 
previous steps but 

  Choose “Envelopes” instead of Form Letters. 
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CHAPTER 12: Printing Receipts and Pledge Statements 

Print Gift Receipts  
From the “File” Menu item  

 Choose “Print Gift Receipts”  
 Receipt Type 
This will bring up a screen in which you can print your Gift 
receipt. It will show you how many new Donations and 
prior for each of three categories. Decide which type of 
receipt you want to print (First time Giving, Regular Giving, 
and Gift in kind).  
The body of each is set up in Receipt/Statements under 
the Edit menu. See Chapter 4. 
 
Options 

 Check the box if you want to use Letterhead paper 
(your centers pre-printed stationary),  

 UN-Check the Check the box and your receipts will 
print with the default letterhead you set up in 
Program Options.  

Receipt Date 
This date defaults to today’s date. If you want a different 
date on your receipts, change it here.  

 Click “Next”  
You can Select-All or Un-Select All then choose the 
individual Event that you want printed. To print just one 
receipt, you can highlight the donors name from the work 
center (Gift area)  

 Click “OK” 
You will now see the letters on your screen. You can print your letters or go back to make changes. 
 On the next page, you will see a sample of a receipt. The receipt shows the receipt number from the main work 
screen, date of donation, amount, and type of payment. On the left of the receipt will be today’s date, donor name 
and address, each donation, event it went to etc. will be the next area of the receipt. This will fill in automatically. 
 

Print Pledge statements 
From the “File” menu 
 Highlight “Print Pledge Statements” the 
following screen will appear: 

 Choose Active, In active or both  
Use the arrows in the Select Aging box to 
specify how many days past due you want 
to run statements 

 Select Aging (how many days past 
the original pledge date) 

 Select the Amount Pledged you 
want for these statements. 

 Select Pay Schedules 
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Print Giving Statements 
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  Choose to print statements by 
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dollar amounts. 

 Choose your options: 
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ill have been

ferences 

 Click “OK” and print stat
After printing your statements  
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Export Gifts to Accounting:  
This wil r Quic
mus e in the 

dit menu before this option will work.   

 screen will appear that is building your export table, 
ollowing screen will appear.  

ant exported. 

, tell you the Export file name and Amount Transferred. 
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E
 
From the File Menu 

 Click “Export to Accounting” 
 A
 Once complete the f

 Select the gifts that you w

 Click “OK” 
The next screen will tell you the export is complete
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You will now be asked if you want to print the gift posting report.   
Click “OK”  

If you choose “Yes”, your Gift Posting report will appear. If you Choose “No” the screen will close. 
 The report will appear on the screen. You can choose to send it to the printer or close it.  

 12-44



CHAPTER 13:  “Reports” Menu Option 

PRINTING AND REVIEWING REPORTS  
Report functions in the DonorPlus program are accessible via the menu list. Generating and printing 
reports is the same for each report available. You have the option to review reports on the screen before 
printing.  
 
From the “File” Menu 

 Click “Reports” 
  A drop down list will appear, highlight the report you want to view  

  Pledge Listing Report 

 Click the Radio button in Sort Records for the type of Pledges you want  
the report to generate. (See samples at end of manual) 
Go to “Select Records” 

 Chose how you want your records sorted. By Date, Donor, Event, 
Appeal or Account. 

 Check ”Include All Events” box If you want to 
run the report on all events.  

 Uncheck if you only want a specific event included in 
your report, or if you want a thon format report. 
 If you uncheck the box: 

 Click the arrow to the right  
Highlight the event you want a report on.  
  Click the “Event” it will now show up in the field 
 Check or uncheck “Include Zero Balance 

Pledges” 
 Check or uncheck to “ Include Donor’s Address” 

The next field is Date Range. 
Highlight the field and type in the date rangt for your 
report. 
Your default printer name should show up in the Select Printer field. If you are using a different printer from the 
default 
If you want to print only certaqin pages, this is where you will also  

 Choose the pages you want to print. On the right hand side you will see “Pages”, uncheck the All box and 
the start and stop fields will highlight. You can now put in the pages that you want to print. 

 Click “OK” 
The report will begin to build. When the report is done building  it will appear on your screen 
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Gift Listing Report  
 Click on “Reports”  
A drop down will appear 

 Click on “Gift Listing” 

 Click the Radio button in” Sort Records” for the type 
of Gifts you want the report to generate.  

 Chose how you want your records sorted. By 
Date, Donor, Event, Appeal etc. 

If you choose to sort by anything other than date, the 
“Select Records” area will highlight. 
Here you can choose to “Include All Events”, “All 
Donors”, “All Appeals” etc. or 

 Uncheck the “Include All” box and select the 
Individual Event, Donor, Appeal etc.,  

 Check ”Include All” box If you want to run the 
report on all events, donors, appeals etc. 

 If you choose to run your report “ByEvent” 
 Uncheck “Include All Events” and “Thon Format” will highlight. You can now choose to run the report in standard 
form or Thon format. (See below for examples) 

 Click the arrow to the right  
Highlight the event you want a report on.  

 Check or uncheck to “ Include Donor’s Address” 
The next field is Date Range. 
Highlight the field and type in the date rangt for your report. 
Your default printer name should show up in the Select Printer field. If you are using a different printer from the 
default 
If you want to print only certaqin pages, this is where you will also: 

 Choose the pages you want to print. On the right hand side you will see “Pages”, uncheck the All box and 
the start and stop fields will highlight. You can now put in the pages that you want to print. 

 Click “OK” 
The report will begin to build. When the report is done building  it will appear on your screen 

 Giving History by Donor Report  

From the “Report” menu 
 Highlight “Giving History by Donor”: 

 Select from the drop list the Donors 
you want to print history  

 You can choose “All Donors”, “Donor ID 
range”, Donor Name, etc. 
“Select Amount Given” in this field you can 
choose to run report by “Any Amount Given”, 
“Amount Given is Between” certain amounts 
or “Amount Given is at Least” a certain 
amount 
You can chose to send Statements to every 
one that donated throughout the year or just to 
those that gave Between certain amounts or 
At Least a certain amount. For example: If you 
want to send statements only to those that gave 250.00 and up for the year you would chose Amount Given is at 
least 250.00. 
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 Choose “Date Range”  

 Click in the “Sort Results by” field, this will allow you to sort the results byPostal Code, Last Name or Donor ID. 
 Choose to “Include” “Donors Address” or “Gift Details” 

 Click “OK” 

 Gift Posting Report 

This report is a list of all gifts selected in you last export to accounting session. This is the same report that is 
available when the export file is complete. A new report will create each time you export gifts to your accounting 
system. 

 Click on “Reports”  
A drop down will appear 

 Click on “Gift Posting” 
On the Report Setup-Gift Posting screen, choose 
“Create New Report” or “Reprint Last Report” 

 Click “OK” 
The Following Report will appear. 

 Donor Follow Up Report 

 Choose the date range according to the dates you 
want to check to see if you have follow ups to do. 

These date and names will be pulled from the entries 
you made in each donor record under “Contact 
Activity”  

This report will create a list of all Donors that you marked to 
follow up on.   

 Donor Profile Report 

This report gives you two options, a detailed list which 
includes Donor ID number, address, day phone, email, 
name and contact name, spouse, sex, birthday, marital 
status, race, religion, church, income level, latest gift and 
amount, Or a quick list which includes Donor ID, name/address, spouse/contact, day phone, marital status, 
race. (A sample of the reports is at the end of this manual). 
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 Staff Listing Report 

 Click on “Reports”  
A drop down will appear 

 Click on “Staff Listing” 
On the Report Setup-Staff Listing screen, choose if you 
want “All Staff Records” or “Active Staff Only” 

 Click “OK” 

“View” Menu Option 
Allows you to refresh your screens after making changes 
Shows what screen you are on and allows you to go to 
different screens. 
 
“Window” Menu Option: Shows what screens you have open 
 

 “Help” Menu Option 
 Click on the ”Help” button  

 Highlight “About DonorPlus” 
This screen tells about the DonorPlus program you are running.  License Type, License Effective Dates, and where 
your program and data are stored on your computer, which will be very helpful, should you need technical support. 
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CHAPTER 14: Importing to QuickBooks 

To import gifts to your accounting program, the first thing you need to do is make sure in the “Program Options” 
Accounting” tab you Clicked on the "Enable Accounting Interface" box 
and chose the accounting program that you use. (Right now, only 
QuickBooks is available to import to but in a future release you will be 
able to import to Business works, MYOB, and Peach Tree.) 
Type in your export Path (C:/Temp) or make a folder and name it so you 
can find the export file. 
 
When importing to QuickBooks the amount goes in as a deposit. Your 
gift posting report should match the deposit total for the day. 
 
In the QuickBooks program: 

 Click “File”  
A drop down list will appear 

 Move your cursor over the word “Utilities” a popup will appear 
 Move your cursor over the word “Import” a popup will appear 

  Click ”Import IIF Files” 
 Highlight the “Dplus.IIf” file 

 Click “Open” 
 
A screen will appear that says: “Your Data has been imported 

  Click “OK” 

  Click on ”Banking" on the left side of the screen of the QuickBooks program. 
The following screen will appear: 

 Click on “Deposit” 
Your deposits will show If it does not  

  Click on the Previous” arrow 
You will go to the previous page, which should show your deposit.  If 
you have your General Ledger and Appeal list set up correctly in the 
DonorPlus program and in QuickBooks, your deposits will show up in the right accounts in QuickBooks. 
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CHAPTER 15: : Report and Receipt / Statement Samples  
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ABC Inc. 
PLEDGE LISTING BY DATE 

05/01/2004 to 06/15/2004Printed  06/118/2004 
 By: Nancy Anders                                     Page         1 
 
 
                                                                                                                                                                                                     Totals                     803.00                            800.00 

       

            

Date ID Name Event Appeal Account Pay Cycle Amount Balance 

   

05/19/2004 8 Kelly, George M. 
1251 E Oak Street 
The Dalles OR 97852 
 
 

2004 Hike for Life General Fund 3001-General Donations Annually 500.00 500.00 

006/02/2004 4 Scott, Lisa L. 
343 W Plaza Drive 
Gresham Or 97080 
 
 

Spring Newsletter General Fund 3001- General Donations Lump Sum 300.00 300.00 
 
 

06/15/2004 5 Smith, Larry E.
100 N Falls Drive 
Milwaukie OR 97252 
 
 

School Round Up School Supplies  Lump Sum 3.00 00.00 
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ABC INC 
GIFT LISTING BY EVENT 

01/01/2004 – 06/15/2004 
 
Printed 06/17/2004 
By: Nancy Anders 

 
                                                                                                                                                                                           Grand Total     $1,875.00 

 
 

 

Date         Receipt ID Name Event Appeal Account Pay Type Amount
05/19/2004 
 
 

0000021 
 
 

8 Kelly, George M 
1251 E Oak Street 
The Dalles OR 97852 
 
 

Annual Mailing General Fund 3001-General Donations Check 
 
 
 
 
_________ 
Event Total 

125.00 
 
 
 
 
_______________ 
 $125.00 

05/20/2004 
 
 
 
06/01/2004 

`0000026 
 
 
 
0000029 

6 
 
 
 
6 

Northwest Portland Bible Chu 
1092 NW Alder Street 
Portland OR 97203 
 
Northwest Portland Bible Chu 
1092 NW Alder Street 
Portland OR 97203 
 

Annual Membership Drive 
 
 
 
Annual Membership Drive 

General Fund 
 
 
 
General Fund 

3001-General Donations 
 
 
 
3001-General Donations 

Check 
 
 
 
Check 
 
_________ 
Event Total 
 

250.00 
 
 
 
1,500.00 
 
_______________ 
$1750.00 
        

       
       

  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ABC Inc 
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GIVING HISTORY BY DONOR 
Detail 

01/01/2004 – 06/15/2004 
 

Printed 06/17/2004                                                                                                                                                                                    Page     1 
By: Nancy Anders        Report includes all donors who gave any amount during this date range 
 
Date 
Received 

Receipt 
No. 

 
Event 

 
Appeal 

Pmt 
Type 

Item 
No. 

Date  
Pledged 

Amount 
Pledged 

Amount 
Received 

Pledge 
Balance 

Donor No. 6          Type: Church                                         Day Phone 503-555-1245 
Northwest Portland Bible Church Best Contact Phone:     Home                                         Best Contact Day:    Tuesday                       Best Contact Time:  1 PM 
1092 NW Alder Street 
Portland OR 97203 
USA 
 
 
01/01/2004  
01/01/2004 

0000029 
0000030 

Annual Membership Drive 
School Round UP 

General Fund 
School Supplies 

Check 
Check 

 
 
 
 

01/01/2004 
01/01/2004 
 
Total Donation 
Amount 

55.00 
55.00 

55.00 
55.00 
 
 
 
 

0.00 
0.00 
 
 

 
                                                                                                                                                                                                   2 item(s)                 Total Donation Amount          110.00 
 
     

 

 

 

 

 

 

 

         Total of All donations      110.00
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CHAPTER 16: Tips-Troubleshooting and Error Messages 

To insure accurate reporting and data integrity, make sure system clock on your computer has the correct date and 
time. (Bottom right hand corner of your computer screen) If you hover over the time, the date will appear. 

Back up DonorPlus data files regularly. ABC Inc will not be responsible for lost data 
It is imperative that you do regular backups. 

We strongly recommend a battery backup. If your power goes out while the program is open you 
could corrupt your data.  

Rebuild the index files (from the menu) on a regular basis. To do this: Select Rebuild Index Files from the File menu 
An alert pop up will display to verify that you want to rebuild the files 

 Click “Yes” 
When the files have been rebuilt another pop up will display notifying you that the process has been completed 

 Click “Ok” 
 Changes to the Program Options and Master Lists affect accuracy and usefulness of statistical data. 

You should not makes changes without the direct authorization of the non-profit organization director, including: 

 DO NOT delete a listing from a Master List 

 DO NOT add a listing to a Master List 

 DO NOT edit a listing in a Master List 

 DO NOT change entries in the Program Options 

However: 
☺ DO add to the Staff List as new staff is added to your non-profit organization.  

Technical Support 
Call the support Help line at 1-877-285-5433 M-F 8 am - 5 PM Pacific Time for free technical support regarding the 
DonorPlus program. Or, email us at assistance@DonorPlus.com.  

Reinstalling DonorPlus 

 DO NOT reinstall the DonorPlus program this could overwrite your data 

Contact the technical support Help line for assistance if a pop up displays instructing you to reinstall the program. 

Power failure 
We recommend the use of a UPS on your computer. It is a battery backup. This will prevent your computer from 
crashing if there is a power failure and give you the time you need to shut down until the power resumes. In the 
event of a power failure, the program automatically rebuilds the index files. The pop up illustrated below will display  

 Click “Yes” if all other users are out of the program. 
If only the last Donor record is missing, you will need to re-enter the record. If multiple Donor records are missing, 
OR 
 If records appear to be corrupted, contact the technical support Help line toll free at 1-877-285-5433 for assistance. 

Access Key Requested 
The DonorPlus program may request the access key at a time other than during the evaluation period, see table 
of errors on following pages.  

Thirty Day expiration Notice 
A pop up screen will come up when you reach the thirty-day point before it is time to renew the license for the 
DonorPlus program at your non-profit organization. 
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 DO NOT Click on “Renew now” unless you have made payment, and have the technical support people 
on the line.  

 Click “Renew later” to bypass this process until a later date. You can still use the program as you have been 
doing. It is just a reminder that you license is coming due. You will receive an invoice by mail or fax so you can 
make payment.  

Buttons 
Opens screen, which shows a list of individual donors, where you can also add new donors 
 
 
 
Not available at this time 
 
Opens a screen which shows event number, date of event, events name, type of event, and 
appeal. In addition, where you go to put in a new event 
 
 
Opens screen, where you add, pledges that donors have made.  
 
 
Opens screen where you add gifts that donors have made,  
 
 
 

Ending a session in the DonorPlus Program 
When you have completed entering or changing information,  

 Do the following: Look at the top of the screen on which you are entering information. You will see two bands 
at the top. The top band says DonorPlus at the left, at the right are three small buttons Click on the button with 
an” X” in it, and it will close the DonorPlus program.  
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